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1 About This Guide 

This guide describes how to install, configure, and use SOPERA Adapter. It contains informa-
tion for administrators who manage a webMethods system, and for application developers 
who create services to communicate with the SOPERA infrastructure. 

To use this guide effectively, you should: 

 Understand the basic concepts of SOPERA Adapter and the SOPERA infrastructure. 

 Be familiar with the set up and operation of the webMethods Integration Server. 

 Have a general idea about how to perform basic tasks with webMethods Designer. 

 Know how to create flow services and/or Java services. 

1.1 Document Titles 

Some Software AG document titles have changed during product releases. The following table 
will help you locate the correct document for a release on the Software AG Documentation 
Web site or the Empower Product Support Web site. 

Documentation Title 

Installation guide  For webMethods product suite 8.0 SP1 
and later, use Software AG Installation 
Guide. 

 For webMethods product suite 8.0 and 
earlier, use webMethods Installation 
Guide. 

Integration Server administration guide  For Integration Server 8.0 SP1 and later, 
use Administering webMethods Integra-
tion Server. 

 For Integration Server 8.0 and earlier, use 
webMethods Integration Server Adminis-
trator's Guide. 

Logging guide  For Integration Server 8.0 SP1 and later, 
use webMethods Audit Logging Guide. 

 For Integration Server 8.0 and earlier, use 
webMethods Logging Guide. 
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1.2 Document Conventions 

Convention Description 

Bold Identifies elements on a user interface. 

Narrow font Identifies storage locations for services on 
webMethods Integration Server, using the 
convention folder.subfolder:service. 

UPPERCASE Identifies keyboard keys. Keys you must press 
simultaneously are joined with a plus sign 
(+). 

Italic Identifies variables for which you must supply 
values specific to your own situation or envi-
ronment. Identifies new terms the first time 
they occur in the text. 

Monospace font Identifies text you must type or messages 
displayed by the system. 

{} Indicates a set of choices from which you 
must choose one. Type only the information 
inside the curly braces. Do not type the { } 
symbols. 

| Separates two mutually exclusive choices in a 
syntax line. Type one of these choices. Do 
not type the | symbol. 

[] Indicates one or more options. Type only the 
information inside the square brackets. Do 
not type the [ ] symbols. 

... Indicates that you can type multiple options 
of the same type. Type only the information. 
Do not type the ellipsis (...). 
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1.3 Documentation Installation 

You can download the product documentation using the Software AG Installer. Depending on 
the release of the webMethods product suite, the location of the downloaded documentation 
will be as shown in the table below. 

For webMethods… The documentation is downloaded to… 

6.x The installation directory of each product. 

7.x A central directory named _documentation in 
the main installation directory (webMethods 
by default). 

8.x A central directory named _documentation in 
the main installation directory (Software AG 
by default). 

1.4 Online Information 

You can find additional information about Software AG products at the locations listed below. 

If you want to… Go to… 

Access the latest version of product 
documentation. 

Software AG Documentation Web site 

http://documentation.softwareag.com 

Find information about product releases 
and tools that you can use to resolve 
problems. 

See the Knowledge Center to: 

 Read technical articles and papers. 

 Download fixes and service packs. 

 Learn about critical alerts. 

See the Products area to: 

Empower Product Support Web site 

https://empower.softwareag.com 
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If you want to… Go to… 

 Download products. 

 Get information about product avail-
ability. 

 Access older versions of product 
documentation. 

 Submit feature/enhancement re-
quests. 

 Access additional articles, demos, 
and tutorials. 

 Obtain technical information, useful 
resources, and online discussion fo-
rums, moderated by Software AG pro-
fessionals, to help you do more with 
Software AG technology. 

 Use the online discussion forums to 
exchange best practices and chat 
with other experts. 

 Expand your knowledge about prod-
uct documentation, code samples, ar-
ticles, online seminars, and tutorials. 

 Link to external Web sites that dis-
cuss open standards and many Web 
technology topics. 

 See how other customers are stream-
lining their operations with technol-
ogy from Software AG. 

Software AG Developer Community for webMeth-
ods 

http://communities.softwareag.com/webmethods 
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2 Overview of webMethods SOPERA Adapter 

2.1 About the Adapter 

webMethods SOPERA Adapter is an Integration Server adapter that allows you to exchange 
data with the SOPERA infrastructure. The adapter provides seamless and real-time communi-
cations to and from the SOPERA ESB. 

Using webMethods SOPERA Adapter, webMethods Integration Server clients can invoke SOPERA 
services and allow the SOPERA infrastructure to call the Integration Server services. For ex-
ample, you can use SOPERA Adapter in a flow that receives data from the SOPERA infrastruc-
ture and then sends the processed data back to the SOPERA infrastructure. 

2.2 Architecture and Components 

webMethods SOPERA Adapter provides a set of user interfaces, services and templates that 
enable you to create integrations with the SOPERA infrastructure. The adapter is provided as 
a single package that must be installed on Integration Server. For detailed installation in-
structions, see Installing webMethods SOPERA Adapter. 
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The following diagram shows at a high level how the adapter components connect to the 
SOPERA infrastructure: 

 
 

 webMethods Integration Server. webMethods SOPERA Adapter is installed and runs on 
webMethods Integration Server. 

 WmART Package. The WmART package provides a common framework for webMethods 
version 7.1 and later adapters to use the Integration Server’s functionality, making Inte-
gration Server the run-time environment for SOPERA Adapter. The WmART package is in-
stalled with Integration Server and provides logging, transaction management, and error 
handling for the adapter and its connections and services. 

 SOPERA Adapter. webMethods SOPERA Adapter is delivered as a single package called 
WmSoperaAdapter. The adapter installation includes templates from which all adapter 
connections, adapter services, adapter listeners, and adapter notifications can be cre-
ated. 

 SOPERA Participant. A SOPERA Participant is a running business application that consumes 
or provides services. SOPERA Adapter enables the communication between the SOPERA in-
frastructure and the webMethods suite by processing requests from SOPERA participants 
and sending requests to those participants. SOPERA Adapter uses the following compo-
nents to interact with the SOPERA infrastructure: 

Java Runtime 

webMethods Integration 
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SOPERA Partici-

pant 

Service Back-

bone 

AdminTool 

WmART Package 

SOPERA Adapter 

(WmSoperaAdapter) 

 

SOPERA 
infrastructure 

Adapter Listeners 

Adapter Connections 

Adapter Services 

Adapter Notifications 
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 AdminTool. The SOPERA AdminTool is the utility used to accomplish the main admini-
stration tasks required for SOPERA Participants, such as looking up and registering ser-
vices. You must specify the path to the SOPERA AdminTool in the SOPERA Adapter con-
figuration file after you install the adapter. 

 Service Backbone. The SOPERA Service Backbone (SBB) library interfaces with the 
SOPERA infrastructure. To access the SOPERA infrastructure, you must specify the path 
to the SOPERA Participant SBB library when you configure SOPERA Adapter connections. 

 SOPERA Infrastructure. The SOPERA infrastructure consists of SOPERA Technical Service 
Providers, the SOPERA Service Registry, a directory server, and a messaging system. web-
Methods SOPERA Adapter communicates with the SOPERA infrastructure to invoke SOPERA 
services or to handle requests from the SOPERA infrastructure to execute services on Inte-
gration Server. 

 Java Runtime. The execution environment for Integration Server and the SOPERA Partici-
pant interacting with webMethods SOPERA Adapter.  

2.3 Adapter Package Management 

webMethods SOPERA Adapter is provided as a package called WmSoperaAdapter that you 
manage like any package on Integration Server. 

There are several considerations regarding how you set up and effectively manage your pack-
ages on Integration Server, such as those described in the following list: 

 Configure user-defined packages for your adapter connections and adapter services. For 
more information, see Managing the Adapter Package. 

 Understand how package dependencies work so you make the best decisions regarding 
how you manage your adapter services and adapter notifications. For more information, 
see Package Dependency Requirements and Guidelines. 

 Control which development groups have access to which adapter services and adapter 
notifications. For more information, see Controlling Group Access. 

 Enable and disable packages. For more information, see Enabling and Disabling Packages. 

 Load, reload, and unload packages. For more information, see Loading, Reloading, and 
Unloading Packages. 

2.4 Adapter Connections 

An adapter connection enables Integration Server to connect to the SOPERA infrastructure at 
run time. You must configure an adapter connection before you can create adapter services 
or notifications. You create one or more connections at design time to use in integrations. 
The number of connections you create depends on your integration needs. You configure con-
nections using Integration Server Administrator. You must have webMethods administrator 
privileges to access the administrative screens of the adapter. For instructions on configuring, 
viewing, editing, enabling, and disabling SOPERA Adapter connections, see Adapter Connec-
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tions. For information about setting user privileges, see the Administering webMethods Inte-
gration Server guide. For a list of tasks that you must do before you can create your connec-
tions, see Before Configuring or Managing Adapter Connections. 

2.4.1 Connection Pools 

Integration Server includes a connection management service that dynamically manages con-
nections and connection pools based on configuration settings that you specify for the con-
nection. By default, connection pooling is enabled for all adapter connections. 

2.4.1.1 Run-Time Behavior of Connection Pools 

In SOPERA Adapter no physical connections are created or managed, but each Connection 
Pool creates a new SBB instance and uses that instance for all operations involving interaction 
with the SOPERA infrastructure. 

Each SBB instance created is identified uniquely with a common AppID, but a different In-
stanceID which maps to the connection pool name. 

It is recommended to restrict the number of connection pools to preserve possibly scarce re-
sources such as memory space or network connections. 

For information about configuring connections, see Adapter Connections. 

2.4.2 Built-in Services for Connections 

Integration Server provides built-in services that enable you to programmatically control con-
nections. You can use the services to enable and disable a connection, and to return usage 
statistics and the current state (Enabled or Disabled) and error status for a connection. These 
services are located in the WmART package, in the pub.art.connection folder. 

For details, see the webMethods Integration Server Built-In Services Reference. 

2.4.3 Changing the Connection Associated with an Adapter Service at Design Time 

Integration Server provides a built-in service that you can use at design time to change the 
connection associated with an adapter service. This built-in service is named 
pub.art.service:setAdapterServiceNodeConnection. Using this service, you can change 
the specific connection associated with an adapter service at design time so that you do not 
need to recreate adapter services. 

NOTE: This built-in service can be run at design time only; do not use it within an Integration 
Server flow or Java service. You must run this service directly from Designer by selecting the 
service in Designer and running it. 

For details about the setAdapterServiceNodeConnection service, see the webMethods Inte-
gration Server Built-In Services Reference. 
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2.5 Adapter Services 

Adapter services enable you to connect to the adapter’s resource (that is the SOPERA infra-
structure) and initiate an operation on the resource from the Integration Server. Every invo-
cation of a SOPERA service by other Integration Server services or Integration Server clients 
goes through an adapter service. 

You call adapter services from flow services or Java services to interact with the SOPERA in-
frastructure. Integration Server uses adapter connections that you defined earlier to execute 
the adapter services. The adapter services invoke SOPERA services on the SOPERA infrastruc-
ture. You can use one of the following communication styles of SOPERA services as part of 
calling the SOPERA services from the adapter: 

 Request-Response. In this style, the service consumer sends a request message to the 
service provider. The provider processes the request and returns a response message to 
the consumer. The request-response operation can be: 

 Blocking. The service blocks the service invocation until a response message is sent to 
the consumer. 

 Non-blocking. The service invocation returns before the response has been received. 

 One-Way. In this style, the service consumer sends a request message to the service pro-
vider, but does not expect any response. 

Adapter services are based on templates provided with SOPERA Adapter. Each template 
represents a specific technique for doing work on a resource. An adapter service template 
contains all the code necessary for interacting with the resource but without the data specifi-
cations. You provide these specifications when you configure a new adapter service. 

Configuring a new service from an adapter service template is straightforward. Using web-
Methods Designer, you assign the service a default adapter connection. 

IMPORTANT! If you are using the adapter with Integration Server 8.0 SP1 or earlier, adapter 
services cannot use connections that are also used for adapter listeners and notifications. 

After you select the connection for the adapter service, you select the adapter service tem-
plate and supply the data specifications, including the mapping of data types from the 
adapter to or from your adapter resource. You use webMethods Designer to configure the 
adapter service. Some familiarity with using webMethods Designer is required. For more in-
formation, see the webMethods Designer Help. 

SOPERA Adapter provides the following adapter service template: 

Adapter Service Template Description 

SOPERA service consumer Invokes SOPERA services. 
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2.6 Adapter Listeners and Listener Notifications 

When the interaction is initiated by the adapter resource (for example, SOPERA calling an 
Integration Server service), SOPERA Adapter uses adapter listeners and notifications. 

Listener notifications provide a mechanism by which any SOPERA participant can invoke ser-
vices on the Integration Server. By creating a notification, an Integration Server service is 
registered as a provider in the SOPERA Service Registry. When a notification is enabled, the 
provider is active and can handle any requests by SOPERA participants. 

After the Integration Server service is executed, the response is sent back to the participant 
using the SOPERA SBB infrastructure. Because there is no processing required at the Integra-
tion Server end after the request is processed in the SOPERA infrastructure, there is no need 
to create a trigger. When the notification is disabled, the IS service will no longer be accessi-
ble by the participants. 

You use Integration Server Administrator to configure and manage adapter notifications. For 
detailed instructions on how to configure listener notifications, see Listener Notifications. 

2.7 webMethods Infrastructure Data Collector Support for the Adapter 

webMethods Infrastructure Data Collector monitors the system and operational data associ-
ated with webMethods run-time components such as Integration Servers, Broker Servers, Bro-
kers, and adapters, and reports the status of these components on Optimize for Infrastructure 
or other external tools. When you start monitoring an Integration Server, Infrastructure Data 
Collector automatically starts monitoring all ART-based adapters that are installed on Integra-
tion Server. 

For information about monitored key performance indicators (KPIs) collected for the moni-
tored adapter components, see the Administering webMethods Optimize Guide. 

2.8 Viewing the Adapter’s Update Level 

You can view the list of updates that have been applied to the adapter. The list of updates 
appears in the Updates field on the adapter's About page in Integration Server Administrator. 
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3 Installing webMethods SOPERA Adapter 

This chapter explains how to install SOPERA Adapter. 

3.1 Overview 

This guide, in conjunction with the Software AG Installation Guide, explains how to install, 
upgrade, and uninstall webMethods SOPERA Adapter 7.1. If you are installing the adapter with 
webMethods Integration Server (prerequisite) or other webMethods products, see the Soft-
ware AG Installation Guide for instructions on installing those products. 

IMPORTANT! If you are installing the adapter with webMethods 8 products, refer to the Soft-
ware AG Installation Guide for instructions. The default installation directory is named Soft-
ware AG\.  

If you are installing the adapter with previous versions of webMethods products, refer to the 
webMethods Installation Guide for instructions. The default installation directory is named 
webMethodsn\.  

This webMethods SOPERA Adapter Installation and User’s Guide refers to the main installation 
directory as installation_directory. 

3.2 Requirements 

For a list of the operating systems and products supported by SOPERA Adapter, see the web-
Methods Adapters System Requirements, available in the webMethods area of the Software 
AG Documentation Web page. 

3.3 Installing SOPERA Adapter 

The instructions in this section are meant to be used with the more complete instructions in 
the Software AG Installation Guide. The instructions explain how to use the Software AG In-
staller wizard. 

NOTE: You must install the SOPERA ESB infrastructure before you install SOPERA Adapter. 

► To install SOPERA Adapter 7.1 

1. Download the Installer from the Empower Product Support Web site. 

2. If you are installing the adapter on an existing Integration Server, shut down Integra-
tion Server. 

3. Start the Installer wizard. 

Choose the webMethods release that includes Integration Server on which to install the 
adapter. For example, if you want to install the adapter on Integration Server 7.1, 
choose the 7.1 release. 
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If you are installing on an existing Integration Server, specify the webMethods installa-
tion directory that contains the host Integration Server. If you are installing both the 
host Integration Server and the adapter, specify the installation directory to use. The 
Installer will install the adapter in the Integration Server_directory\packages directory. 

4. In the product selection list, select Adapters > webMethods SOPERA Adapter 7.1.  

5. To install documentation for the adapter, select Documentation > Adapter Readmes 
and Documentation. 

NOTE: This step will install the documentation for all adapters. The Installer will install 
the documentation files in the installation_directory\_documentation directory.  

6. Alternatively, you can download the adapter documentation at a later time from the 
Software AG Documentation Web page (http://documentation.softwareag.com/). 

7. After the Installer completes the adapter installation, close the Installer. 

8. Copy the following files from the SBB_directory\lib directory into the Integration 
Server_directory\packages\WmSoperaAdapter\code\jars directory: 

sbb-papi.jar 

jax-qname-namespace.jar 

sbb-factory-impl.jar 

9. Copy the following files from the AdminTool_directory\lib directory into the Integra-
tion Server_directory\packages\WmSoperaAdapter\code\jars directory: 

jaxmeapi-0.5.1.jar 

jaxmexs-0.5.1.jar 

sbb-admin-tool.jar 

privilegemanagement-jaxb.jar 

privilegemanagement-proxy.jar 

sbb-configrepos-scopepath.jar 

sbb-instance-proxy-plugin.jar 

sbb-proxy-util.jar 

jaxme2-0.5.1.jar 

jaxme2-rt-0.5.1.jar 

userAccountManagement-proxy.jar                       

userAccountManagement-jaxb.jar                         

sbb-toolsuite-service-utilities.jar                

sbb-toolsuite-common.jar                         

10. Start the host Integration Server. 
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3.4 Completing the Installation 

To complete the installation, you need to set a number of SOPERA specific properties in the 
SOPERA Adapter configuration file. 

► To set the properties in the sopera.config file 

1. Navigate to the IntegrationServer_directory\packages\WmSoperaAdapter\config direc-
tory. 

2. Open the sopera.config file in a text editor. 

3. Specify the following properties as described in the following table: 

Property Description/Action 

org.sopware.sbb.home Set to the home directory of the SBB Library 
installation on the local system. This parame-
ter is required. For example, 
C:\SOPERA\ServiceBackbone 

org.sopware.admintool.home Set to the home directory of the Admin Tool 
location on the local system. This parameter 
is required. For example, 
C:\SOPERA\AdminTool 

org.sopware.transport.http.enable Optional. Set the HTTP inbound transport for 
the SBB Library. Valid values are: 

 true Enables HTTP. This is the default 
value. 

 false Disables HTTP. 

org.sopware.transport.http.port Optional. Set the HTTP inbound port for the 
SBB Library running on the Java VM. If you do 
not specify a value, the adapter will throw 
an error when you attempt to enable the 
adapter notification. 

org.sopware.transport.https.enable Optional. Set the HTTPS inbound transport 
for the SBB Library. Valid values are: 

 true Enables HTTPS. 

 false Disables HTTPS. This is the default 
value. 
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Property Description/Action 

org.sopware.transport.https.port Optional. Set the HTTPS inbound port for the 
SBB Library running on the Java VM. 

org.sopware.transport.https.keystore Optional. Set the file name of the keystore 
used by the SBB Library for enabling the 
HTTPS transport. 

org.sopware.transport.https.password Optional. The password for accessing the 
keystore used by the SBB Library for enabling 
the HTTPS transport. 

org.sopware.transport.https.clientauth Optional. Set client authentication for the 
HTTP or HTTPS inbound transport. Valid val-
ues are: 

 true Enables client authentication. 

 false Disables client authentication. This 
is the default value. 

NOTE: You can remove or comment the optional properties in the sopera.config file. For 
details about these system properties, see the SOPERA Configuration Reference Guide. 

4. Save the sopera.config file. 

3.5 Uninstalling SOPERA Adapter 

The instructions in this section are meant to be used with the uninstallation instructions in 
the Software AG Installation Guide. 

► To uninstall  SOPERA Adapter 7.1 

1. Shut down the host Integration Server. You do not need to shut down any other web-
Methods products or applications that are running on your machine. 

2. Start the Software AG Uninstaller, selecting the webMethods installation directory that 
contains the host Integration Server. In the product selection list, select Adapters > 
webMethods SOPERA Adapter 7.1. 

3. After the Uninstaller completes, restart the host Integration Server. 

4. The Uninstaller removes all SOPERA Adapter 7.1-related files that were installed. How-
ever, it does not delete files created after you installed the adapter (for example, jar 
files copied into Integration Server_directory\packages\WmSoperaAdapter\ 
code\jars\static\ or configuration files), nor does it delete the adapter directory struc-
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ture. You can go to the Integration Server_directory\packages directory and delete the 
WmSoperaAdapter directory. 

5. The Uninstaller does not delete any user-defined SOPERA Adapter 7.1 components such 
as connections, adapter services, or adapter notifications. Because these components 
will not work without the adapter, delete them manually, either at the file system 
level or using Designer. For instructions, see the Designer Service Development Help. 
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4 Package Management 

The following sections describe how to set up and manage your webMethods SOPERA Adapter 
packages, set up Access Control Lists (ACLs), and use the adapter in a clustered environment. 

4.1 Managing the Adapter Package 

SOPERA Adapter is provided as a package called WmSoperaAdapter. You manage the 
WmSoperaAdapter package as you would manage any package on Integration Server. 

When you create connections, adapter services, and adapter notifications, define them in 
user-defined packages rather than in the WmSoperaAdapter package. Doing so will allow you 
to manage the package more easily. 

As you create user-defined packages in which to store connections, adapter services, and 
adapter notifications, use the package management functionality provided in Designer and set 
the user-defined packages to have a dependency on the WmSoperaAdapter package. That 
way, when the WmSoperaAdapter package loads or reloads, the user-defined packages load 
automatically. See the following diagram: 

 

WmART WmSoperaAdapter Sopera Connec-
tions Package 
(user-defined) 

Sopera Adapter 
Services Package 
(user-defined) 

Sopera Listeners 
Package 

(user-defined) 

Sopera Notifica-
tions Package 
(user-defined) 

KEY: 
A sets a dependency on B: 

A                                   B 
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Package management tasks include: 

 Setting package dependencies (see Package Dependency Requirements and Guidelines). 

 Enabling and Disabling Packages. 

 Loading, Reloading, and Unloading Packages. 

 Importing and Exporting Packages. 

 Controlling Group Access. 

4.1.1 Package Dependency Requirements and Guidelines 

This section contains a list of dependency requirements and guidelines for user-defined pack-
ages. For instructions for setting package dependencies, see the webMethods Designer Help. 

 By default, the WmSoperaAdapter package has a dependency on the WmART package. Do 
not change this dependency. 

 A user-defined package must have a dependency on its associated adapter package, 
WmSoperaAdapter. 

 Package dependencies ensure that at startup Integration Server automatically loads or 
reloads all packages in the proper order: the WmART package first, the adapter package 
next, and the user-defined package(s) last. The WmART package is automatically installed 
when you install Integration Server. You should not need to manually reload the WmART 
package. 

 If the connections and adapter services of an adapter are defined in different packages, 
then: 

 A package that contains the connection(s) must have a dependency on the adapter 
package, WmSoperaAdapter. 

 Packages that contain adapter services must have a dependency on their associated 
connection package. 

 Keep connections for different adapters in separate packages so that you do not create 
interdependencies between adapters. If a package contains connections for two different 
adapters, and you reload one of the adapter packages, the connections for both adapters 
will reload automatically. 

 Integration Server will not allow you to enable a package if it has a dependency on an-
other package that is disabled. That is, before you can enable your package, you must en-
able all packages on which your package depends. For information about enabling pack-
ages, see Enabling and Disabling Packages. 

 Integration Server will allow you to disable a package even if another package that is en-
abled has a dependency on it. Therefore, you must manually disable any user-defined 
packages that have a dependency on the adapter package before you disable the adapter 
package. 

 You can name connections, adapter services, and notifications the same name provided 
that they are in different folders and packages. 
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4.1.2 Enabling and Disabling Packages 

All packages are automatically enabled by default. When you want to temporarily prohibit 
access to the elements in a package, disable the package. When you disable a package, the 
server unloads all of its elements from memory. Disabling a package prevents Integration 
Server from loading that package at startup. A disabled package will remain disabled until you 
explicitly enable it using Integration Server Administrator. 

► To enable a package 

1. In Integration Server Administrator: Packages > Management. 

2. Click No in the Enabled column. The server displays Yes in the Enabled column. 

NOTE: Enabling an adapter package will not cause its associated user-defined package(s) to 
be reloaded. For information about reloading packages, see Controlling Group Access. 

IMPORTANT! Before you manually enable a user-defined package, you must first enable its 
associated adapter package (WmSoperaAdapter). Similarly, if your adapter has multiple user-
defined packages, and you want to disable some of them, disable the adapter package first. 
Otherwise, errors will be issued when you try to access the remaining enabled user-defined 
packages. 

► To disable a package 

1. In Integration Server Administrator: Packages > Management. 

2. Click Yes in the Enabled column for the package that you want to disable. The 
server issues a prompt to verify that you want to disable the package. Click OK to 
enable the package. When the package is disabled, the server displays No in the En-
abled column. 

A disabled adapter will: 

 Remain disabled until you explicitly enable it using Integration Server Administrator. 

 Not be listed in webMethods Designer. 

4.1.3 Loading, Reloading, and Unloading Packages 

As described above in Package Dependency Requirements and Guidelines, if user-defined 
packages are properly configured with a dependency on the adapter package, at startup Inte-
gration Server automatically loads or reloads all packages in the proper order: the WmART 
package first, the adapter package next, and the node package(s) last. You should not need 
to manually reload the WmART package. 

4.1.3.1 Reloading Packages Manually 

Reloading a user-defined package will not cause its associated adapter package to be re-
loaded. You can reload adapter packages and user-defined packages from either Integration 
Server Administrator (by clicking the Reload icon on the Management window) or from the 



webMethods SOPERA Adapter 

           webMethods SOPERA Adapter Installation and User’s Guide 7.1 22 

webMethods Developer (by right-clicking the package and selecting the Reload Package option 
from the menu). 

4.1.3.2 Unloading Packages 

At shutdown, Integration Server unloads packages in the reverse order in which it loaded 
them: it unloads the node package(s) first, the adapter package next, and the WmART pack-
age last (assuming the dependencies are correct). 

4.1.4 Importing and Exporting Packages 

You import and export packages using Designer. Exporting allows you to export the package to 
a .zip file and save it to your hard drive. The .zip file can then be imported for use by another 
package. 

IMPORTANT! Do not rename packages you export; the rename function is comparable to mov-
ing a package, and when you import the renamed package, you lose any triggers, connections, 
and notifications associated with this package. 

For details about importing and exporting packages, see the webMethods Designer Help. 

4.1.5 Setting Package Dependencies 

You set package dependencies if a given package needs services in another package to load 
before it can load. For example, any packages you create for the SOPERA Adapter services 
should identify webMethods SOPERA Adapter package (WmSoperaAdapter) as a package de-
pendency because they require services in WmSoperaAdapter to load first. Use the following 
guidelines: 

 Set package dependencies from the adapter service package to the package containing 
the connection if you configure a connection in one package and the adapter services in 
another package. That is, the package that contains the connection should load before 
the adapter service package. 

When you set this package dependency, it ensures that if someone disables the connection 
package and then re-enables it, the adapter services will reload correctly. 

 If both the connection and adapter services are in the same package, set this package to 
have a dependency on the WmSoperaAdapter package.  

 In general, packages containing connections should have a dependency set to the adapter 
package itself. That is, the adapter service package should depend on the adapter con-
nection package, which should depend on the adapter package. Similarly, if the adapter 
services are in the same package as the connections, the only dependency that you need 
to set is between the adapter connection package and the adapter package. 

For more information about setting package dependencies, see the webMethods Designer 
Help. 
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4.2 Controlling Group Access 

To control which development group has access to which adapter services, use access control 
lists (ACLs). You can use ACLs to prevent one development group from inadvertently updating 
the work of another group, or to allow or deny access to services that are restricted to one 
group but not to others. 

For general information about assigning and managing ACLs, see the webMethods Designer 
Help. 
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5 Adapter Connections 

This chapter describes how to configure and manage SOPERA Adapter connections. 

5.1.1 Before Configuring or Managing Adapter Connections 

► To prepare to configure or manage an adapter connection 

1. Install webMethods Integration Server and SOPERA Adapter on the same machine. 
For details, see Installing webMethods SOPERA Adapter. 

2. Make sure you have webMethods administrator privileges so that you can access the 
SOPERA Adapter’s administrative screens. For information about setting user privi-
leges, see the webMethods Integration Server Administrator’s Guide. 

3. Start Integration Server and Integration Server Administrator, if they are not already 
running. 

4. Using Integration Server Administrator, make sure the WmSoperaAdapter package is 
enabled. See Enabling and Disabling Packages for instructions. 

5. Using webMethods Designer, create a user-defined package to contain connections, 
if you have not already done so. See Managing the Adapter Package for details. 

5.1.2 Configuring Adapter Connections 

SOPERA Adapter requires a connection to a SOPERA infrastructure whenever services from the 
SOPERA infrastructure are to be invoked; that is, whenever SOPERA Adapter acts as a client 
for a SOPERA infrastructure. A connection is also required when an Integration Server service 
is to be invoked through the adapter by any of the SOPERA participants. 

When you configure SOPERA Adapter connections, you specify information that Integration 
Server uses to connect to a SOPERA participant. In most cases, you will need to configure at 
least two adapter connections: one for the adapter listener and one for all adapter services.  

IMPORTANT! If you are using the adapter with Integration Server 8.0 SP1 or earlier, adapter 
services cannot use connections that are also used for adapter listeners and notifications. 

You configure SOPERA Adapter connections using Integration Server Administrator as de-
scribed in the following procedure: 

► To configure an adapter connection 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. On the Connections screen, click Configure New Connection. 

3. On the Connection Type screen, click SOPERA Connection as the connection type. 
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4. For a basic connection, complete the following fields in the SOPERA Adapter section: 

Field Description/Action 

Package The package in which to create the connection. You must 
create the package using Designer before you can specify 
it using this parameter. For general information about 
creating packages, see the webMethods Designer Help. 

NOTE: Configure the connection in a user-defined pack-
age rather than in the adapter’s package. See Package 
Management for other important considerations when 
creating packages for SOPERA Adapter. 

Folder Name The folder in which to create the connection. 

Connection Name The name of the new connection. 

5. In the Connection Properties section, complete the following fields using the values 
from your configured SOPERA infrastructure: 

Field Description 

SOPERA Location The location of the SOPERA infrastructure. The default 
value is generic_location. 

SOPERA User The SOPERA default user name for this adapter connec-
tion. For example, SOPAdministrator. 

SOPERA Password The password for the SOPERA default user name. 

NOTE: You must retype the password in the Retype 
SOPERA Password field. 

6. In the Connection Management Properties section, complete the following fields to 
configure connection pool sizes: 

Field Description/Action 

Enable Connection 
Pooling 

Enables the connection to use connection pooling. 
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Field Description/Action 

Default: true 

For more information about connection pooling, see 
Connection Pools. 

Minimum Pool Size The minimum number of connection objects that remain 
in the connection pool at all times. When the adapter 
creates the pool, it creates this number of connections.  

Default: 1 

Maximum Pool Size The maximum number of connection objects that can 
exist in the connection pool. When the connection pool 
has reached its maximum number of connections, the 
adapter will reuse any inactive connections in the pool 
or, if all connections are active, it will wait for a connec-
tion to become available. 

Default: 10 

Pool Increment Size If connection pooling is enabled, this field specifies the 
number of connections by which the pool will be incre-
mented if connections are needed, up to the maximum 
pool size. 

Default: 1 

Block Timeout (msec) If connection pooling is enabled, this field specifies the 
number of milliseconds that Integration Server will wait 
to obtain a connection with the SOPERA infrastructure 
before it times out and returns an error. 

Default: 1000 

Expire Timeout 
(msec) 

If connection pooling is enabled, this field specifies the 
number of milliseconds that an inactive connection can 
remain in the pool before it is closed and removed from 
the pool. For example, to specify 10 seconds, specify 
10000. Enter 0 to specify no timeout. 

Default: 1000 
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Field Description/Action 

NOTE: The adapter will never violate the Minimum Con-
nections parameter. These connections remain in the 
pool regardless of how long they are inactive. 

Startup Retry Count The number of times that the system should attempt to 
initialize the connection pool at startup if the initial at-
tempt fails. 

Default: 0 

Startup Backoff 
Timeout (sec) 

The minimum number of connection objects that remain 
in the connection pool at all times. When the adapter 
creates the pool, it creates this number of connections. 

Default: 10 

7. Click Save Connection. 

The connection that you configured appears on the adapter’s Connections screen and in the 
Designer Package Navigator view. 

By default, when you configure a connection, it is not enabled. For more information about 
enabling connections, see Enabling Adapter Connections. 

5.1.3 Enabling Adapter Connections 

A connection must be enabled before you can configure any adapter service using the connec-
tion, or before an adapter service can use the connection at run time. You enable adapter 
connections using Integration Server Administrator. 

NOTE: When you reload a package that contains enabled connections, the connections will 
automatically be enabled when the package reloads. If the package contains connections that 
are disabled, they will remain disabled when the package reloads. 

► To enable a connection 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. On the Connections screen, click No in the Enabled column for the connection you 
want to enable. 

Integration Server Administrator enables the adapter connection and displays Yes in 
the Enabled column. 
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5.1.4 Viewing Adapter Connections 

You can view adapter connections and each connection’s parameters from Integration Server 
Administrator. 

► To view the adapter connections using Integration Server Administrator 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. The Connections screen appears, listing all the current connections. 

2. To view a connection’s parameters: 

a) On the Connections screen, click the View icon for the connection you want to see. 

b) The View Connection screen displays the parameters for the connection. For descrip-
tions of the connection parameters, see Configuring Adapter Connections. 

3. Click Return to SOPERA Adapter Connections to return to the Connections screen. 

5.1.5 Disabling Adapter Connections 

SOPERA Adapter connections must be disabled before you can edit or delete them. You dis-
able adapter connections using Integration Server Administrator. 

► To disable a connection 

4. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

5. On the Connections screen, click Yes in the Enabled column for the connection you 
want to disable. 

6. The adapter connection becomes disabled and you see a No in the Enabled column. 

5.1.6 Editing Adapter Connections 

If a connection parameter changes, or if you want to redefine parameters that a connection 
uses when connecting to a SOPERA infrastructure, you can update a connection’s parameters 
using Integration Server Administrator. 

► To edit a connection 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. Make sure that the connection is disabled before editing it. See Disabling Adapter Con-
nections for instructions. 

3. On the Connections screen, click the Edit icon for the connection you want to edit. 

The Edit Connection screen displays the current parameters for the connection. Update 
the connection’s parameters by typing or selecting the values you want to specify. 

For descriptions of the connection parameters, see Configuring Adapter Connections. 

4. Click Save Changes to save the connection and return to the Connections screen. 
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5.1.7 Copying Adapter Connections 

You can copy an existing SOPERA Adapter connection to configure a new connection with the 
same or similar connection properties without having to re-type all of the properties for the 
connection. You copy adapter connections using Integration Server Administrator. 

► To copy a connection 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. On the Connections screen, click the Copy icon for the connection you want to copy. 

The Copy Connection screen displays the current parameters for the connection you 
want to copy. Name the new connection, specify a package name and folder name, and 
edit any connection parameters as needed by typing or selecting the values you want to 
specify. 

NOTE: When you copy a connection, the new connection does not save the password of 
the original connection. You must enter and then retype the password before you can 
save the new connection. 

For descriptions of the connection parameters, see Configuring Adapter Connections. 

3. Click Save Connection to save the connection and return to the Connections screen. 

5.1.8 Deleting Adapter Connections 

If you no longer want to use a particular SOPERA Adapter connection, you can delete it by 
following the instructions in this section. You delete adapter connections using Integration 
Server Administrator. 

If you delete a connection, the adapter services or notifications that are defined to use the 
connection will no longer work. However, you can change which connection an adapter ser-
vice uses. Therefore, if you delete a connection, you can assign a different connection to an 
adapter service and re-use the service. To do this, you use the built-in webMethods function 
setAdapterServiceNodeConnection. For more information, see Changing the Connection 
Associated with an Adapter Service at Design Time. 

► To delete a connection 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. Make sure that the connection is disabled before deleting. To disable the connection, 
click Yes in the Enabled column and click OK to confirm. The Enabled column now 
shows No (disabled) for the connection. 

3. On the Connections screen, click the Delete icon for the connection you want to de-
lete. 

Integration Server deletes the adapter connection. 
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6 Adapter Services 

This chapter describes how to configure adapter services to communicate with the SOPERA 
infrastructure. 

6.1 Before Configuring or Managing Adapter Services 

► To prepare to configure or manage an adapter service 

1. Start your Integration Server and Integration Server Administrator, if they are not al-
ready running. 

2. Make sure you have Integration Server administrator privileges so that you can access 
SOPERA Adapter administrative screens. For information about setting user privileges, 
see the Administering webMethods Integration Server guide. 

3. Using Integration Server Administrator, make sure the WmSoperaAdapter package is 
enabled. For instructions, see Enabling and Disabling Packages. 

4. Using Integration Server Administrator, configure an adapter connection to use with the 
adapter service. For instructions, see Configuring Adapter Connections. 

5. Start Designer if it is not already running. 

6. Using Designer, create a package to contain adapter services, if you have not already 
done so. 

When you configure adapter services, define them in user-defined packages instead of 
in the WmSoperaAdapter package. For more information about managing packages for 
the adapter, see Package Management. 

6.2 Using Adapter Services 

The following table lists the task required to use adapter services. 

Task Use this tool 

1. Configure an adapter connection. For details, see Configuring 
Adapter Connections. 

Integration Server Ad-
ministrator 

2. Select the appropriate adapter service template and configure 
the adapter service. For instructions for configuring notifications, 
see Configuring Adapter Services. 

Designer 

3. If you plan to use an Integration Server flow or Java service to 
invoke the adapter service, design the flow or Java service to use 
this adapter service. 

Designer 
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Task Use this tool 

For information about flow and Java services, see the webMeth-
ods Designer Help. 

4. Manage the adapter service. Integration Server Ad-
ministrator and Designer 

6.3 Configuring Adapter Services 

Every invocation of a SOPERA service by other Integration Server services or Integration Server 
clients goes through an adapter service. The SOPERA Adapter provides the SOPERA service 
consumer template that performs the actual invocation of a SOPERA service. 

You configure adapter services in Designer. In general, you can use the SOPERA service con-
sumer template to configure two kinds of service invocation adapter services: 

 Adapter service tailored to a specific SOPERA service and operation. 

 Adapter service that generically invokes any SOPERA service and operation. 

6.3.1 Adapter Service Tailored to a Specific SOPERA Service and Operation 

This configuration is accomplished by selecting a specific SOPERA service and one of its op-
erations that the adapter service will provide. In this case, one adapter service is required for 
every used SOPERA service operation. In most cases, it is better to use one adapter service 
per SOPERA service. The SOPERA registry ensures that a valid SOPERA service with a valid op-
eration is used. Additionally, these adapter services are more easily reused in flow services 
and business processes. 

For this configuration, use the SOPERA Invocation tab in the adapter template to configure 
the parameters for the new service as described in the following procedure. 

► To configure a service invocation adapter service: 

1. Start Designer. 

2. Right-click the package in which the service should be contained and select New > 
Adapter Service. 

3. Select the parent namespace and type a name for the adapter service. 

4. Click Next. 

5. Select SOPERA Adapter as the adapter type and click Next. 



webMethods SOPERA Adapter 

           webMethods SOPERA Adapter Installation and User’s Guide 7.1 32 

6. Select the appropriate Adapter Connection Name and click Next. 

IMPORTANT! If you are using the adapter with Integration Server 8.0 SP1 or earlier, 
adapter services cannot use connections that are also used for adapter listeners and 
notifications. 

7. Select the SOPERA service consumer adapter template and click Finish. 

The adapter service editor for the invocation service appears. 

8. In the service editor, select the Adapter Settings tab at any time to confirm adapter 
service properties such as Adapter Name, Adapter Connection Name, and Adapter 
Service Template, as necessary. 

9. In the service editor, select the SOPERA Invocation tab and specify the following 
fields: 

Field Description 

Service name The name and the path to the SOPERA service to invoke. For ex-
ample, 
{http://services.sopware.org/ExampleURI}ExampleService

Operation 
name 

The name of the operation the adapter service must perform. 
For example, RequestResponseOperation. 

Interaction 
style 

The way in which the adapter service interacts with the SOPERA 
infrastructure. 

The value for this field is based on the value you specify in the 
Operation name field. For example, if you select RequestRe-
sponseOperation in the Operation name field, the value in the 
Interaction style field automatically changes to RE-
QUEST_RESPONSE. 

Input docu-
ment type 

The fully-qualified document type name for the input IS docu-
ment. For example, doc.myservice.input:inDoc 

IMPORTANT! Specify a unique name for the input document 
type. If you specify an existing document type name, the IS 
document type will not be generated correctly. 

Output docu-
ment type 

The fully-qualified document type name for the output IS docu-
ment. For example, doc.myservice.output:inDoc 

IMPORTANT! Specify a unique name for the output document 
type. If you specify an existing document type name, the IS 
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Field Description 

document type will not be generated correctly. 

NOTE: When the Interaction style is ONEWAY, no output docu-
ment type is required or generated. 

Policy The conditions under which the adapter service invokes a 
SOPERA service. Policies are retrieved from the SOPERA Service 
Registry based on the location configured in the Connection Set-
tings. For information about configuring the adapter connection 
settings, see Configuring Adapter Connections. 

Blocking Determines the invocation style of the adapter service: 

 When selected, the adapter service is configured as blocking 
and it waits for the actual service result. By default, blocking 
is selected. 

 When not selected, the adapter service is configured as non-
blocking and returns a response message handler. This mes-
sage handler can be passed to the 
pub.wmsopera.service:getNonBlockingServiceResponse 
utility service, using a flow service that gets the actual re-
sult. This allows a complex service to start as soon as all of 
its input parameters are available and to only block when the 
output of the service is needed. 

Return the 
actual mes-
sage object 

Determines how the service provider returns the response mes-
sage to the service consumer.  

 When not selected, the response message is transformed into 
Integration Server data structures. This is the default. 

 When selected, the response message returns as an actual 
message object. This is useful when a response message con-
tains attachments or is very large, because an actual mes-
sage object enables you to retrieve the attachments or the 
message content in a stream-based manner. 

NOTE: If the response contains attachments, then the response 
is returned as an object whether you select this option or not. 
Ensure that the adapter services are configured appropriately. 

10. From the File menu, click Save. 
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Using the XML schema of the SOPERA operations retrieved from the registry, the SOPERA 
Adapter automatically creates Integration Server input and output document types adhering 
to the operation’s schema.  

When the adapter service is invoked, the data is automatically transformed into XML and 
passed to the SOPERA service. When the service returns the result, the XML is then trans-
formed back into structured data elements that business processes, services, and clients can 
easily use inside the Integration Server. 

6.3.2 Generic Service Invocation Adapter Services 

In this configuration the SOPERA service and operation are parameters of the adapter service. 
The benefits of this approach are increased flexibility (run-time selection of SOPERA service is 
possible) and less configuration overhead (only one adapter service can be used for multiple 
SOPERA service invocation). 

To configure a generic invocation adapter service, use the same procedure as described in the 
Adapter Service Tailored to a Specific SOPERA Service and Operation section, but leave the 
fields on the SOPERA Invocation tab blank. Specify configuration values as input values for 
the adapter service parameters that you can view on the Input/Output tab of the adapter 
service template: 

Input Parameters Description 

serviceName The name of the SOPERA service. 

operationName The name of the operation to perform for the adapter ser-
vice. 

policyId The policy identifier for the SOPERA service. 

requestMessageString The request that the adapter service sends as an XML String. 

Output Parameters Description 

responseMessageString The response message as an XML String, when the Return 
the actual message object field on the SOPERA Invocation 
tab is set to false. 

responseMessageObject The response message as an Object, when the Return the 
actual message object field on the SOPERA Invocation tab 
is set to true. 
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When the response contains attachments, the response al-
ways returns as a responseMessageObject. 

responseMessageHandler The message handler passed to the 
pub.wmsopera.service:getNonBlockingServiceResponse 
utility service when the communication style is request-
response non-blocking. 

6.4 Testing Adapter Services 

You use Designer to test adapter services. 

For more information about testing and debugging services, see the webMethods Designer 
Help. 

► To test adapter services 

1. In Designer, expand the package and folder that contain the service you want to test. 

2. Double-click the service you want to test. 

Designer displays the configured service in the service template’s adapter service edi-
tor. 

3. Select Run > Run As > Run Service. 

4. For every service input field, you will be prompted to enter an input value. Enter a 
value for each input field and then click OK. 

5. Click the Service Result tab to view the output from this service. 

6.5 Viewing Adapter Services 

You use Designer to view adapter services. 

► To view adapter services 

1. In Designer, expand the package and folder that contain the service you want to view. 

2. Double-click the service you want to view. 

Designer displays the configured service in the service template’s adapter service edi-
tor. 

6.6 Editing Adapter Services 

You use Designer to edit adapter services. Before you edit adapter services, make sure that 
you enable the connection. For instructions on enabling connections, see Enabling Adapter 
Connections. 
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► To edit adapter services 

1. In Designer, expand the package and folder that contain the service you want to edit. 

2. Double-click the service you want to edit. 

Designer displays the configured service in the service template’s adapter service edi-
tor. 

3. Right-click the service and select Lock for Edit. 

4. Modify the values for the service’s parameters as needed. For detailed descriptions of 
the service’s parameters, see Configuring Adapter Services. 

5. After you have completed your modifications, save the service. 

6. Right-click the service and select Unlock. 

7. Save the service. 

6.7 Deleting Adapter Services 

You use Designer to delete adapter services. 

► To delete adapter services 

1. In Designer, expand the package and folder that contain the service you want to de-
lete. 

2. Right-click the service you want to delete and then select Delete. 

6.8 Automatic Data Validation and Reloading Adapter Values 

You can enable SOPERA Adapter to reload and validate user-defined data for adapter services 
at design time in Designer.  

The automatic data validation for adapter services is enabled by default in Designer. When 
the option is selected, Designer always validates values for adapter services for all webMeth-
ods WmART-based adapters installed on Integration Server. 

► To disable automatic data validation for all adapter services 

1. Start Designer. 

2. Select Window > Preferences > Software AG > Service Development > Adapter Ser-
vice/Notification Editor. 

3. Disable the Automatic data validation option. 

4. Click OK. 

The option to always reload values for adapter services is not enabled by default in Designer. 
If you enable that option, Designer will always reload values for all webMethods WmART-
based adapters installed on Integration Server. 
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► To reload the adapter values for all adapter services 

1. Start Designer. 

2. Select Window > Preferences > Software AG > Service Development > Adapter Ser-
vice/Notification Editor. 

3. Enable the Automatic polling of adapter metadata option. 

4. Click OK. 

For more information about the adapter service/notification editor and other Designer menu 
options and toolbar icons, see the webMethods Designer Help. 
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7 Adapter Notifications 

This chapter describes how to configure and manage listeners and notifications. 

7.1 Listeners 

This section describes how to create, modify, and delete listeners. 

7.1.1 Before You Configure New Listeners 

► To prepare to configure a new listener 

1. Make sure that you have webMethods administrator privileges so that you can access 
SOPERA Adapter’s administrative screens. For information about setting user privileges, 
see the Administering webMethods Integration Server guide. 

2. Start Integration Server and Integration Server Administrator, if they are not already 
running. 

3. Using Integration Server Administrator, make sure that the WmSoperaAdapter package 
is enabled. To verify the status of the WmSoperaAdapter package, see Enabling and 
Disabling Packages. 

4. Using Designer, create a user-defined package to contain the listener, if you have not 
already done so. For more information about managing packages, see Package Man-
agement for details. 

7.1.2 Configuring Listeners 

SOPERA Adapter requires a listener to listen for inbound requests from a SOPERA infrastruc-
ture. Use the following procedure to create a listener on SOPERA Adapter to respond to re-
quests issued by the SOPERA infrastructure. 

► To create a listener on SOPERA Adapter 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. 

3. Select Configure new listener and then select SOPERA invocation listener from the 
list of available listener types. 

4. Complete the following fields on the Configure Listener Type screen: 

Field Description/Action 

Package The package in which to create the listener. You must 
create the package using Designer before you can specify 
it using this parameter. For general information about 
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Field Description/Action 

creating packages, see the webMethods Designer Help. 

NOTE: Configure the listener in a user-defined package 
rather than in the adapter’s package. See Package Man-
agement for other important considerations when creat-
ing packages for SOPERA Adapter. 

Folder Name The folder in which to create the listener. 

Listener Name The name of the new listener. 

Connection Name The name of the connection to associate with the new 
listener. 

From the list of connections, select an appropriate con-
nection that you created on the Configure Connections 
Type screen. 

IMPORTANT! If you are using the adapter with Integration 
Server 8.0 SP1 or earlier, listeners and listener notifica-
tions cannot share connections with adapter services. 
However, listeners can share connections with other lis-
teners. 

Retry Limit The number of times the adapter tries to reconnect if the 
adapter fails to connect, or loses connection with the 
SOPERA infrastructure. 

Default: 5 

Retry Backoff Time-
out 

The number of seconds that elapse between each of the 
retries specified in the retry limit. 

Default: 10 

5. Click Save Listener. 

The adapter listener is created. The listener name is prefixed by the folder name and is 
separated by a colon. For example: If the folder name is “Folder1” and the listener 
name is “Listener1”, then the listener name in the Listeners screen will be 
“Folder1:Listener1”. 



webMethods SOPERA Adapter 

           webMethods SOPERA Adapter Installation and User’s Guide 7.1 40 

7.1.3 Enabling Listeners 

After you have configured notifications, you must enable the listener so that the associated 
notifications will communicate appropriately with the listener at run time. You enable the 
listeners using Integration Server Administrator. 

The Status column indicates the readiness of the listener. If the status is Succeeded, the lis-
tener is ready to be enabled. If the status is Failed, an error occurred during startup. If an 
error occurs during startup, the state will not change to Enabled when refreshing the page. 
Errors at this stage typically indicate a problem with either the listener configuration or the 
network. Review the listener settings and check the network. 

NOTE: When you reload a package that contains enabled listeners, the listeners will be en-
abled automatically when the package reloads. If the package contains disabled listeners, 
they will remain disabled when the package reloads. 

► To enable a listener 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. 

3. On the Listeners screen, select Enabled from the list in the State field. Integration 
Server Administrator enables the listener. 

4. The state changes to Pending enabled. After refreshing the Listeners page, you should 
see the state changed to Enabled. 

After a listener is enabled, a connection exists between SOPERA Adapter and the 
SOPERA infrastructure. 

TIP! The Enable all suspended link helps you change the state quickly for multiple listeners. 

7.1.4 Viewing Listeners 

You can view listeners and each listener’s parameters from Integration Server Administrator. 
You can also view the notification order of a listener. 

► To view listeners 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. The Listeners screen appears, listing all 
of the current listeners. 

3. To view a listener’s parameters: 

a) On the Listeners screen, click the View icon for the listener that you want to see. 

b) The View Listener screen displays the parameters for the listener. 

4. Click View Notification Order to view the notification order of a listener. 
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The View Listener screen displays the order of the notifications for the listener. To 
change the notification order for the listener, refer to the procedure in Editing Listeners 
for detailed instructions. 

5. Click Return to SOPERA Adapter Listeners to return to the Listeners screen. 

7.1.5 Editing Listeners 

You use Integration Server Administrator to edit the listener in the following situations: 

 If you need to select a newly configured connection, or if you need to change any listener 
properties you can update the listener parameters. 

 If you need to change the order of the notifications that are associated with the listener. 

► To edit a listener 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. 

3. On the Listeners screen, make sure that the listener is disabled before editing. To dis-
able the listener, see Disabling Listeners. 

4. On the Listeners screen, click the Edit icon for the listener that you want to edit. 

The Edit Listener screen displays the current parameters for the listener. Update the 
listener’s parameters by typing or selecting the values you want to specify. 

For descriptions of the listener parameters, see Configuring Listener. 

5. Click Save Changes to save the listener and return to the Listeners screen. 

► To edit the notification order of a listener 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. 

3. On the Listeners screen, make sure that the listener is disabled before editing. To dis-
able the listener, see Disabling Listeners for details. 

4. On the Listeners screen, click the Edit icon for the listener that you want to edit. 

5. On the Edit Listener screen, click Edit Notification Order. 

6. On the Edit Notification Order screen, use the Up and Down buttons to determine the 
processing order in which SOPERA Adapter invokes the notifications. 

NOTE: For better processing results, arrange your notifications from ascending to de-
scending order, starting with the most detailed notifications to the least detailed notifi-
cations. 

7. Click Save Changes. 

8. Click Return to Edit Listeners to return to the Edit Listener screen. 
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7.1.6 Copying Listeners 

You can copy an existing listener to create a new listener with the same or similar properties 
without having to type or specify all properties for the listener. You copy adapter listeners 
using Integration Server Administrator. 

► To copy a listener 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. 

3. On the Listeners screen, click the Copy icon for the listener that you want to copy. 

The Copy Listener screen displays the current parameters for the listener that you want 
to copy. Name the new listener and edit any listener parameters as needed by typing or 
selecting the values you want to specify. 

For descriptions of the listener parameters, see Configuring Listener. 

4. Click Save Changes to save the listener and return to the Listeners screen. 

7.1.7 Deleting Listeners 

If you no longer want to use a listener, use the following instructions to delete the listener. 
You use Integration Server Administrator to delete listeners. 

IMPORTANT! Ensure that there are no notifications attached to the listener that you delete. 
You cannot change which listener a notification uses after the notification is configured. 
However, you can change the parameters for an existing listener. For instructions, see Editing 
Listeners. 

► To delete a listener 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. 

3. On the Listeners screen, make sure that the listener is disabled before deleting it. To 
disable the listener, see Disabling Listeners for details. 

4. On the Listeners screen, click the Delete icon for the listener you want to delete. 

Integration Server deletes the listener. 

7.1.8 Suspending Listeners 

You can suspend listeners for an indefinite period of time. Suspended listeners cannot be ed-
ited or deleted. 

IMPORTANT! Suspending listeners for SOPERA Adapter has the same effect as disabling them. 
For more information about disabling listeners, see Disabling Listeners. 
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► To suspend listeners 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. 

3. Click Suspend all enabled to change the state to suspended for multiple listeners. 

When you suspend a listener, the action may not take effect right away. You may have to 
wait as long as the time specified in the Timeout parameter for the listener. If one or more 
messages appear on the queue within that time interval, the adapter may receive and process 
the first message. 

7.1.9 Disabling Listeners 

Listeners must be disabled before you can edit or delete them. You disable listeners using 
Integration Server Administrator. 

► To disable a listener 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, click Listeners. 

3. On the Listeners screen, select Disabled from the list in the State field. Integration 
Server Administrator disables the listener. 

When you disable a listener, the action may not take effect right away. You may have to wait 
as long as the time specified in the Timeout parameter for the listener. If one or more mes-
sages appear on the queue within that time interval, the adapter may receive and process the 
first message. 

7.2 Listener Notifications 

This section describes how to create, modify, and delete listeners notifications. 

► To prepare to configure a new listener notification 

1. Make sure that you have webMethods administrator privileges so that you can access 
SOPERA Adapter’s administrative screens. For information about setting user privileges, 
see the Administering webMethods Integration Server guide. 

2. Start Integration Server and Integration Server Administrator, if they are not already 
running. 

3. Using Integration Server Administrator, make sure that the WmSoperaAdapter package 
is enabled. To verify the status of the WmSoperaAdapter package, see Enabling and 
Disabling Packages. 

4. Configure a listener using Integration Server Administrator. For more information on 
how to configure a new listener, see Configuring Listeners. 
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5. Using Designer, create a user-defined package to contain the listener, if you have not 
already done so. For more information about managing packages, see Package Man-
agement for details. 

7.2.1 Dependencies for Listener Notifications 

The following table lists other objects you must configure or tasks you must complete to use 
listener notifications: 

Task Use this tool 

1. Configure an adapter connection. For details, see Configuring 
Adapter Connections. 

Integration Server Ad-
ministrator 

2. Configure an adapter listener. For details, see Configuring Lis-
teners. 

Integration Server Ad-
ministrator 

3. Configure the notification. For instructions on how to configure 
notifications, see Configuring Listener Notifications. 

Designer 

4. Enable the notifications. For instructions on how to enable no-
tifications, see Enabling Listener Notifications. 

Integration Server Ad-
ministrator 

7.2.2 Configuring Listener Notifications 

You configure listener notifications using Designer. 

► To configure a listener notification 

1. Start Designer. 

2. Right-click the package in which the notification should be contained and select New > 
Adapter Notification. 

3. Select the parent namespace and type a name for the adapter notification. 

4. Click Next. 

5. Select SOPERA Adapter as the adapter type and click Next. 

6. Select SOPERA provider invoking an IS service as the adapter notification template 
and click Next. 

7. Select the appropriate Notification Listener Name and click Next. 

8. Click Finish. 

Designer creates a listener notification and a publishable document type, and the editor 
for the adapter notification appears. 
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9. In the editor for adapter notifications, select the Adapter Settings tab to confirm noti-
fication properties such as the Adapter Name, Adapter Listener Name, and Adapter 
Notification Template as necessary. 

10.  In the editor for adapter notifications, select the SOPERA provider invoking an IS ser-
vice tab and specify the following fields: 

 Field Description 

SOPERA Service 
Name 

The name of the service under which the specified Integration 
Server service will be registered. For example: 
{http://service.sopware.org/ExampleURI}ExampleService 

SOPERA Opera-
tion Name 

The name of the operation in the specified SOPERA service. For 
example: NotificationFS 

Integration 
Server Service 
Name 

The qualified name of the Integration Server service that will 
be exposed through the SOPERA infrastructure. For example: 
pub.math:addInts 

NOTE: The input and output parameters of the specified Inte-
gration Server service must be document references. The input 
parameter is required, but the output parameter is optional. If 
no output parameter is found, the adapter creates a ONEWAY 
operation. Otherwise, the adapter creates a REQUEST-
RESPONSE operation in the SOPERA infrastructure. 

Use Existing 
SOPERA Service 

Select this check box if you want to use an existing SOPERA 
service specification. 

When selected, the SOPERA service and operation will be 
loaded from the SOPERA Service Registry. You can then select 
the service and operation you require in the SOPERA Service 
Name and SOPERA Operation Name fields.  

IMPORTANT! When this option is selected, the Integration 
Server service will overwrite the current provider definition 
stored in the registry. 

Use HTTPS Select this check box if you want to offer Integration Server 
services via HTTPS. The HTTP and HTTPS ports are configured 
in the SOPERA Adapter configuration file. See Completing the 
Installation for details. 
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 Field Description 

Use Plain XML When selected, the service description will not contain any of 
the data structure given in the signature. 

NOTE: Selecting this option works for services with one re-
questMessage input parameter and one responseMessage out-
put parameter, and is recommended when conversion to IData 
is not necessary or should be avoided for performance reasons. 

11. From the File menu, select Save. 

7.2.3 Enabling Listener Notifications 

After you configure a listener notification, you need to enable it using Integration Server Ad-
ministrator. 

► To enable a listener notification 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, select Listener Notifications. 

3. On the Listener Notifications screen, click No in the Enabled column for the listener 
notification you want to enable. 

The Integration Server Administrator enables the listener notification and displays a Yes 
in the Enabled column. 

7.2.4 Testing Listener Notifications 

You can test listener notifications to ensure that you have configured them correctly. 

► To test listener notifications 

1. Configure a listener using Integration Server Administrator. For instructions to config-
ure a listener, see Configuring Listeners. 

2. Configure a listener notification using Designer. For instructions to configure a notifica-
tion, see Configuring Listener Notifications. 

3. Enable the listener notification using Integration Server Administrator. For instructions 
to enable a listener notification, see Enabling Listener Notifications. 

4. Enable the listener using Integration Server Administrator. For instructions to enable a 
listener, see Enabling Listeners. 

5. On your SOPERA infrastructure, invoke the service registered when creating the listener 
notification. 
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7.2.5 Viewing Listener Notifications 

You use Integration Server Administrator or Designer to view listener notifications. 

► To view listener notifications using Integration Server Administrator 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, select Listener Notifications. 

The Listener Notifications screen appears, listing all the listener notifications. 

► To view a listener notification using Designer 

1. In Designer, expand the package and folder that contain the listener notification you 
want to view. 

2. Click the listener notification that you want to view. 

Designer displays the configured listener notification in the adapter’s adapter notifica-
tion editor. 

7.2.6 Editing Listener Notifications 

You use Designer to edit listener notifications. When editing the listener notification, you can 
also edit the publishable document type associated with the asynchronous listener notifica-
tions. 

Listener notifications must be disabled before you can edit or delete them. 

► To edit a listener notification 

1. In Designer, expand the package and folder that contain the listener notification you 
want to edit. 

2. Select the listener notification you want to edit. 

3. The adapter’s adapter notification editor displays details about the configured listener 
notification. 

4. Modify the values for the listener notification’s parameters as needed. For detailed de-
scriptions of the listener notification’s parameters, see Configuring Listener Notifica-
tions. 

NOTE: Because listener notifications inherently depend on listeners, you cannot change 
a listener for a listener notification after you configure it. 

7.2.7 Deleting Listener Notifications 

If you no longer want to use a particular SOPERA Adapter listener notification, you can delete 
it by following the instructions in this section. You delete listener notifications using De-
signer. Listener notifications must be disabled before you can edit or delete them. 
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► To delete a listener notification 

1. In Designer, expand the package and folder that contains the listener notification you 
want to delete. 

2. Right-click the listener notification and click Delete. 

7.2.8 Disabling Listener Notifications 

You disable listener notifications using Integration Server Administrator. 

► To disable a listener notification 

1. In the Integration Server Administrator navigation area, click Adapters > SOPERA 
Adapter. 

2. In the SOPERA Adapter menu, select Listener Notifications. 

The Listener Notifications screen appears, listing all the listener notifications. 

3. On the Listener Notifications screen, click Yes in the Enabled column for the listener 
notification you want to disable. 

4. The listener notification becomes disabled and No displays in the Enabled column. 
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8 Integration Scenarios 

8.1 Calling Request-Response and One-Way SOPERA Services 

Calling request-response and one-way SOPERA services means that a request message is sent 
out using an instance of the SOPERA Service Backbone (SBB). For request-response, addition-
ally, a response message is expected.  

Request-response and one-way SOPERA services can be integrated quite similarly. An adapter 
service template is configured to call a specific SOPERA service. The resulting adapter service 
can then be used in Integration Server flows. 

8.2 Calling Integration Server Services from the SOPERA Infrastructure 

You call Integration Server Services from SOPERA when you want to: 

 Offer custom Integration Server services (implemented, for example, as flow or Java ser-
vices) 

 Offer Integration Server adapter functionality 

 Implement existing SOPERA service specification 

 Offer built-in Integration Server services 

NOTE: Offering built-in Integration Server services is not recommended because built-in Inte-
gration Server services are rather low-level, technical services. 

When you want to call Integration Server Services from the SOPERA infrastructure, make sure 
that you: 

 Configure the HTTPS Transport. To offer the Integration Server services via HTTPS, se-
lect the Use HTTPS check box when you configure the adapter notification and configure 
an HTTPS port. For information about configuring adapter notifications, see Configuring 
Listener Notifications. For information about configuring an HTTPS port, see Completing 
the Installation. 

 Export and Import the Security Certificate. To export the certificate from the 
WmSoperaAdapter keystore, use this command: 

C:\temp>keytool -export -alias wmsopera -keystore keystore_wmsopera.jks 
 -rfc -file wmsopera.cer 

To import the certificate into the client keystore, use this command: 

C:\temp>keytool -import -alias WmSoperaAdapter -file wmsopera.cer 
 -keystore  

C:\SOPERA\ServiceBackbone\work\components\org.sopware.SOPEngine\install\ 

conf\transport\certs.jks 
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9 Adapter Logging 

The following section describes logging information for SOPERA Adapter. 

9.1 Adapter Logging Levels 

SOPERA Adapter uses Integration Server logging mechanism to log messages. You can config-
ure and view Integration Server logs to monitor and troubleshoot SOPERA Adapter. For de-
tailed information about logging in Integration Server, including instructions for configuring 
and viewing the different kinds of logs supported by the server, see the webMethods Logging 
Guide. 

9.1.1 Configuring Adapter Logging Levels 

Beginning with Integration Server 7.1, you can configure different logging levels for SOPERA 
Adapter. 

► To access the adapter's logging information 

1. From the Integration Server Administrator screen, select Settings > Logging. 

The Logging Settings screen appears. The Loggers section has Adapters included in the 
Facility section. 

2. Expand the Adapters tree to see a list of all installed adapters with their code number 
and adapter description, along with the logging level. 

► To change logging settings for the adapter 

1. From the Integration Server Administrator screen, select Settings > Logging. 

The Logging Settings screen appears. From the Logging Settings screen, select Edit Log-
ging Settings. Select the required Level of logging for SOPERA Adapter. 

2. Click Save Changes. 

For complete information about specifying the amount and type of information to include in 
the log, see the webMethods Audit Logging Guide. 

9.2 SOPERA Message Logging 

You can also configure how the SBB Library generates logging output. The SOPERA Adapter 
SBB Library uses the standard Java logging mechanism provided by the java.util.logging pack-
age.  
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To enable logging for the Service Backbone, you must set the java.util.logging.config.file JVM 
system property to point to a properties file that specifies the logging configuration for the 
SBB library.  For example: 

-Djava.util.logging.config.file=mylogging.properties  

If the java.util.logging.config.file system property is not defined, the Log Manager reads its 
initial configuration from a properties file located in the $<JAVA_DIR>/lib/logging.properties  
JRE directory, where $<JAVA_DIR> is the JAVA directory used by the Integration Server. 

A sample configuration file can be located in your local SOPERA ServiceBackbone installation 
at: 

SOPWare_directory/ServiceBackbone/work/components/org.sopware.SOPEngine/install/ 
conf/logging.properties 

For more information about how to configure Java logging, see the SOPERA Installation and 
Operations Guide and the Sun documentation. 

9.3 Adapter Message Logging 

Integration Server maintains several types of logs; however, SOPERA Adapter only logs mes-
sages to the audit, error, and server logs. Because SOPERA Adapter works in conjunction with 
the WmART package, the adapter’s messages and exceptions typically appear within log mes-
sages for the WmART package. The following table describes the type of messages SOPERA 
Adapter logs into each type of Integration Server log: 

Log Description 

Audit You can monitor individual adapter services using the audit log as you 
would audit any service in the Integration Server. The audit properties for 
an adapter service are available in the SOPERA Adapter service template 
on the Audit tab. 

Error SOPERA Adapter automatically posts fatal-level and error-level log mes-
sages to the error log. These log messages appear as adapter run-time 
messages. 

Server SOPERA Adapter posts messages to the server log, depending on how the 
server log is configured. Fatal-level through debug-level log messages 
appear as adapter run-time log messages. Trace-level log messages ap-
pear as SOPERA Adapter log messages. 
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The SOPERA Adapter’s log messages appear in the following format, ADA.0510.nnnnc, where: 

 ADA is the facility code that indicates that the message is from an adapter. 

 0510 is the SOPERA Adapter major code, which indicates that the error is generated by 
SOPERA Adapter. 

 nnnn represents the error’s minor code. For detailed descriptions of the SOPERA Adapter’s 
minor codes, see SOPERA Adapter Error Codes. 

 c represents the message’s severity level (optional). 

To monitor SOPERA Adapter’s log messages in the Server log, ensure that your server log’s 
logging settings are configured to monitor the following facilities: 

 0113 Adapter Runtime (Managed Object) 

 0114 Adapter Runtime 

 0115 Adapter Runtime (Listener) 

 0116 Adapter Runtime (Notification) 

 0117 Adapter Runtime (Adapter Service) 

 0118 Adapter Runtime (Connection) 

 0121 Adapter Runtime (SCC Transaction Manager) 

 0126 Adapter Runtime (SCC Connection Manager) 

9.4 SOPERA Adapter Exception Handling 

If a SOPERA Adapter object (for example, a connection or service) encounters an error with 
the SOPERA Infrastructure, it will throw an adapter error coupled with the SOPERA error, ex-
actly as it was thrown by the SOPERA infrastructure. For example, if an adapter service fails 
on the SOPERA infrastructure at run time because the adapter failed to invoke a SOPERA ser-
vice, you will receive an adapter error. This error indicates that the adapter service failed, 
and the adapter error will contain the specific error generated on the SOPERA infrastructure 
indicating why the service failed. 

9.5 SOPERA Adapter Error Codes 

The following section lists the SOPERA Adapter's error codes and provides information on the 
error message, reason, and possible action for each error. 

5502 Unable to create the node document_name under package package_name. Ensure that you 
have sufficient permission. 

Cause: Error. Occurs when the adapter fails to create folders for document generation. 

Response: Make sure that you have webMethods administrator privileges and sufficient credentials. For 
information about setting user privileges, see the Administering webMethods Integration Server guide. 



   webMethods SOPERA Adapter 

webMethods SOPERA Adapter Installation and User’s Guide 7.1 53

5555 Exception interfacing the Service Backbone. 

Cause: Error. Generic error that occurs during the handling of the SOPERA Service Backbone library. 

Response: Check the SOPERA infrastructure error in the logs to see the cause of the exception and 
take appropriate action. If the problem persists, contact Software AG Global Support. 

5556 Failed to release message handler for service IS_service_name. 

Cause: Error. Occurs when the adapter fails to release the message handler for the specified Integra-
tion Server service. 

Response: Check the SOPERA infrastructure error in the logs to see the cause of the exception and 
take appropriate action. If the problem persists, contact Software AG Global Support. 

5557 Failed to create service skeleton for service IS_service_name. 

Cause: Error. Occurs when the adapter fails to create the specified Integration Server service as a 
SOPERA service. 

Response: Check the SOPERA infrastructure error in the logs to see the cause of the exception and 
take appropriate action. If the problem persists, contact Software AG Global Support. 

5558 Unable to retrieve XML string from SOPERA incoming message. 

Cause: Error. Occurs when receiving an XML message from the SOPERA infrastructure. 

Response: Verify the input message to the adapter service or notification. 

5559 Unable to invoke IS service to satisfy SOPERA request. It might be that the service does not 
adhere to the predefined signature (one input parameter incomingMessage and one output pa-
rameter outgoing message). 

Cause: Error. Occurs when the adapter fails to invoke an Integration Server service in response to a 
request from the SOPERA infrastructure. 

Response: Check the Integration Server error logs for the Integration Server service invoked and verify 
the implementation of the Integration Server service. 

5561 Unable to produce outgoing message for SOPERA. 

Cause: Error. Occurs when the adapter fails to create a response message from the Integration Server 
service invoked by the SOPERA infrastructure. 

Response: Check the SOPERA infrastructure error in the logs to see the cause of the exception and 
take appropriate action. If the problem persists, contact Software AG Global Support. 

5562 Unable to send service response via SOPERA. 

Cause: Error. Occurs when the adapter fails to send an Integration Server service response message to 
SOPERA. 
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Response: Check the SOPERA infrastructure error in the logs to see the cause of the exception and 
take appropriate action. If the problem persists, contact Software AG Global Support. 

5563 SBB error while invoking SOPERA service SOPERA_service_name operation operation_name 
with request message request_message_sent. 

Cause: Error. Generic error that occurs when invoking an adapter service. 

Response: Verify the values of the input parameters for the service. Check the SOPERA infrastructure 
error in the logs to see the cause of the exception and take appropriate action. If the problem persists, 
contact Software AG Global Support. 

5564 Error identifying how many attachments the response message contains. 

Cause: Error. Occurs when attempting to get the attachment count in the response message in a Re-
questResponse Call or the pub.wmsopera.service:getNonBlockingServiceResponse service. 

Response: Check the SOPERA infrastructure error in the logs to see the cause of the exception and 
take appropriate action. If the problem persists, contact Software AG Global Support. 

5567 No message handler delivered. 

Cause: Error. No responseMessageHandler passed to the 
pub.wmsopera.service:getNonBlockingServiceResponse service. 

Response: Ensure that the message handler object is passed as input to  the 
pub.wmsopera.service:getNonBlockingServiceResponse service. 

5568 Error generating IS document document_name in package package_name. Errors: error_text 

Cause: Error. Occurs when the adapter fails to generate a document from a SOPERA service. The value 
of error_text is null when no document is generated. 

Response: Ensure that the correct folder name is appended to both the Input document type and the 
Output document type. 

5569 Invalid value of document type. Either folder name or document type name is missing in 
document_type_value 

Cause: Error. Occurs when either the folder name or document type name is missing from the value of 
the timeout parameter. 

Response: Ensure that the document type value has folder name and document name separated by ':'. 

5570 Unable to read and transform SOPERA request message into readable format for the  Integra-
tion Server service. 

Cause: Error. Occurs when the adapter fails to read or transform a SOPERA request message into an 
Integration Server service. 

Response: Check the SOPERA infrastructure error in the logs to see the cause of the exception and 
take appropriate action. If the problem persists, contact Software AG Global Support. 



   webMethods SOPERA Adapter 

webMethods SOPERA Adapter Installation and User’s Guide 7.1 55

5571 Unable to instantiate Admin Facade at Admin_Facade_location. 

Cause: Error. Occurs when there is an error during the AdminFacade creation when enabling an 
adapter connection or starting Integration Server. 

Response: Verify the connection parameters in the SOPERA Adapter sopera.config file, located in the 
IntegrationServer_directory\packages\WmSoperaAdapter\config directory. For information about the 
SOPERA Adapter configuration file, see Completing the Installation. 

5572 Unable to instantiate ServiceBackbone. 

Cause: Error. Occurs when there is an error during the ServiceBackbone creation when enabling an 
adapter connection or starting Integration Server. 

Response: Verify the connection parameters in the SOPERA Adapter sopera.config file, located in the 
IntegrationServer_directory\packages\WmSoperaAdapter\config directory. For information about the 
SOPERA Adapter configuration file, see Completing the Installation. 

5601 Unable to create/register the one-way service IS_service_name in the SOPERA registry. 

Cause: Error. Occurs when there is an issue during the creation or registration of an Integration Server 
service as a one-way service in the SOPERA service registry. 

Response: Check the AdminFacade error in the logs to see the cause of the exception and take appro-
priate action. If the problem persists, contact Software AG Global Support. 

5602 Unable to create/register the request-response service IS_service_name in the SOPERA regis-
try. 

Cause: Error. Occurs when there is an issue during the creation or registration of an Integration Server 
service as a request-response service in the SOPERA service registry. 

Response: Check the AdminFacade error in the logs to see the cause of the exception and take appro-
priate action. If the problem persists, contact Software AG Global Support. 

5603 Transport not enabled or port not configured. 

Cause: Error. Occurs when the transport port property is not configured properly in the SOPERA 
Adapter configuration file. 

Response: Configure the transport port property as required. For information about the SOPERA 
Adapter configuration file, see Completing the Installation. 

5604 Unable to create/register provider for service: IS_service_name 

Cause: Error. Occurs for any error occur during the registration of a new SOPERA service provider for 
the specified Integration Server service. 

Response: Check the AdminFacade error in the logs to see the cause of the exception and take appro-
priate action. If the problem persists, contact Software AG Global Support. 
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5605 Required parameters not provided for the notification. 

Cause: Error. Validation error for a notification in which required message parameters are missing. 

Response: Check all required parameters in the notification and set them as required. For information 
about configuring adapter notifications, see Configuring Listener Notifications. 

5606 Invalid SOPERA service name service_name found. The service name should be of the format 
{<namespace_uri>}<service_name>. 

Cause: Error. Occurs when an incorrect SOPERA service name is specified while configuring the notifi-
cation to invoke an Integration Server service via SOPERA. 

Response: Check if the service name is specified in the following format and correct it if it is not: 
{<namespace_uri}<service_name> 
Example: 
{http://myservice.com/example} TestService 

5573 Error while retrieving the SOPERA service service_name from the registry. 

Cause: Error. Occurs when attempting to retrieve the specified adapter service name instance from 
the registry name. 

Response: Ensure that the service name is correct and the service is registered. See the AdminFacade 
logs for the exact reason for the error. 

5574 Error while processing input parameters while invoking SOPERA service service_name 

Cause: Error. Occurs when the adapter is unable to convert the input message into XML or the request 
message is missing. 

Response: Recreate the input document type for the specified service. 

5575 Fault message received - error encountered in service provider while invoking SOPERA ser-
vice. 

Cause: Error. The exception occurs during the invocation of the SOPERA provider service. 

Response: Check the error logs at the SOPERA provider end. 

5576 SBB Error encountered when receiving non-blocking response from provider. 

Cause: Error. Occurs when the adapter is unable to get non-blocking response from the 
pub.wmsopera.service:getNonBlockingServiceResponse service. 

Response: Check the SOPERA infrastructure error in the logs to see the cause of the exception and 
take appropriate action. If the problem persists, contact Software AG Global Support. 

5577 Invalid value of timeout parameter. 

Cause: Error. Occurs when the value of the timeout parameter is not numeric. 
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Response: Verify the value of the timeout parameter passed in the 
pub.wmsopera.service:getNonBlockingServiceResponse service. 
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10 Adapter Built-in Services 

10.1 Overview 

This appendix describes the built-in services provided with the WmSoperaAdapter package of 
webMethods SOPERA Adapter. 

10.1.1 WmSoperaAdapter Package 

The WmSoperaAdapter package contains the public services used to manage the SOPERA ser-
vices. 

pub.wmsopera.admin.adminService 

Contains the package startup and shutdown services. 

pub.wmsopera.service 

Contains the utility services to manage the SOPERA services. 

pub:wmsopera.service:getNonBlockingServiceResponse 

Processes the returned request message handler, when the SOPERA service consumer 
adapter service template is configured as a non-blocking request-response service. 

Input Parameters 

timeout String Optional. The timeout, in milliseconds, specifies how long to 
wait for a response message. Valid values are: 

 A negative value means wait forever. 

 0 means return immediately regardless of whether the message 
has arrived. This is the default value. 

messageAsObject String Optional. Valid values are: 

 true The response is returned as an Object. 

 false The response is returned as a String. This is the default 
value. 

responseMessageHandler Object The message handler returned from the SOPERA service con-
sumer adapter service template.  

Typically, you should use a flow service to map the responseMes-
sageHandler output value returned from the adapter service to this 
parameter.  
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Output Parameters 

responseMessageObject Object The response message as an Object, when the mes-
sageAsObject input parameter is set to true. 

responseMessageString String The response message as a String, when the messsa-
geAsObject input parameter is set to false. 

 


